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Keyboard shortcuts in Excel for Windows 

Applies To: Excel 2016 Excel 2013 Excel 2010 Excel 2007 More... Less  

Many users find that using an external keyboard with keyboard shortcuts for Excel 2016 on Windows 

helps them work more efficiently. For users with mobility or vision disabilities, keyboard shortcuts can 

be easier than using the touchscreen and are an essential alternative to using a mouse. This article 

itemizes the keyboard shortcuts for Excel 2016 on Windows. 

Notes:  

The shortcuts in this topic refer to the US keyboard layout. Keys for other layouts might not correspond 

exactly to the keys on a US keyboard. 
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If a shortcut requires pressing two or more keys at the same time, this topic separates the keys with a 

plus sign (+). If you have to press one key immediately after another, the keys are separated by a comma 

(,). 

2016 2013 2010 2007  

  

This article describes keyboard shortcuts, function keys, and some other common shortcut keys for Excel 

2016. This includes the access keys that you can use for ribbon commands. For Excel Online, see 

Keyboard shortcuts in Excel Online. 

Notes:  

To keep this reference available when you work, you may want to print this topic. To print this topic, 

press Ctrl+P. 

Get these keyboard shortcuts in a Word document at this link: Excel 2016 for Windows keyboard 

shortcuts 

Frequently used shortcuts 

If you're new to the Ribbon, the information in this section can help you understand the Ribbon's 

keyboard shortcut model. The Ribbon comes with new shortcuts, called Key Tips, which you can make 

appear when you press the Alt key. The Ribbon groups related commands on tabs. For example, on the 

Home tab, the Number group includes the Number Format command. 

This table lists the most frequently used shortcuts in Excel 2016. 

To do this  Press  

Close a workbook Ctrl+W 

Open a workbook Ctrl+O 

Go to the Home tab Alt+H 

Save a workbook Ctrl+S 

Copy Ctrl+C 

Paste Ctrl+V 

Undo Ctrl+Z 
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To do this  Press  

Remove cell contents Delete key 

Choose a fill color Alt+H, H 

Cut Ctrl+X 

Go to Insert tab Alt+N 

Bold Ctrl+B 

Center align cell contents Alt+H, A, then C 

Go to Page Layout tab Alt+P 

Go to Data tab Alt+A 

Go to View tab Alt+W 

Open context menu 
Shift+F10, or 

Context key 

Add borders Alt+H, B 

Delete column Alt+H,D, then C 

Go to Formula tab Alt+M 

Hide the selected rows Ctrl+9 

Hide the selected columns Ctrl+0 
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Ribbon keyboard shortcuts 

If you're new to the ribbon, the information in this section can help you understand the ribbon's 

keyboard shortcut model. 

When you press the Alt key, letters appear in small images, called KeyTips, next to tabs and commands 

on the ribbon, as shown in the following image. 

https://support.office.com/en-us/article/Keyboard-shortcuts-in-Excel-for-Windows-1798d9d5-842a-42b8-9c99-9b7213f0040f#top


 

You can combine these letters with Alt to make shortcuts called Access Keys for ribbon commands. For 

example, Alt+H opens the Home tab, and Alt+Q goes to the Tell me box. 

Press Alt again to see KeyTips for the commands on any tab. 

Access keys for ribbon tabs  

To go directly to a tab on the ribbon, press one of the following access keys: 

To do this  Press  

Open the Tell me box on the Ribbon and type a search term for assistance or Help 

content. 

Alt+Q, and then 

enter the search 

term. 

Open the File page and use Backstage view. Alt+F 

Open the Home tab and format text and numbers and use the Find tool. Alt+H 

Open the Insert tab and insert PivotTables, charts, add-ins, Sparklines, pictures, 

shapes, headers, or text boxes. 
Alt+N 

Open the Page Layout tab and work with themes, page setup, scale, and 

alignment. 
Alt+P 

Open the Formulas tab and insert, trace, and customize functions and calculations. Alt+M 

Open the Data tab and connect to, sort, filter, analyze, and work with data. Alt+A 

Open the Review tab and check spelling, add comments, and protect sheets and 

workbooks. 
Alt+R 

Open the View tab and preview page breaks and layouts, show and hide gridlines 

and headings, set zoom magnification, manage windows and panes, and view 

macros. 

Alt+W 

Top of Page  
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Work in the ribbon with the keyboard  

To do this  Press  

Select the active tab of the ribbon, and activate the 

access keys. 

Alt or F10. To move to a different tab, use access 

keys or the arrow keys. 

Move the focus to commands on the ribbon. Tab or Shift+Tab 

Move down, up, left, or right, respectively, among 

the items on the Ribbon. 

The Down Arrow, Up Arrow, Left Arrow, or Right 

Arrow key 

Activate a selected button. Spacebar or Enter 

Open the list for a selected command. The Down Arrow key 

Open the menu for a selected button. Alt+Down Arrow 

When a menu or submenu is open, move to the next 

command. 
Down Arrow key 

Expand or collapse the ribbon. Ctrl+F1 

Open a context menu. 

Shift+F10 

Or, on a Windows keyboard 

Context key (between the right Alt and right Ctrl 

keys) 

Move to the submenu when a main menu is open or 

selected. 
Left Arrow key 

Top of Page  

Excel keyboard shortcut reference 

Keyboard shortcuts for navigating in cells 

To do this  Press  

Move to the previous cell in a worksheet or the previous option in a dialog 

box. 
Shift+Tab 

Move one cell up in a worksheet. Up Arrow key 
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To do this  Press  

Move one cell down in a worksheet. Down Arrow key 

Move one cell left in a worksheet. Left Arrow key 

Move one cell right in a worksheet. Right Arrow key 

Move to the edge of the current data region in a worksheet. Ctrl+arrow key 

Enter End mode, move to the next nonblank cell in the same column or row 

as the active cell, and turn off End mode. If the cells are blank, move to the 

last cell in the row or column. 

End, arrow key 

Move to the last cell on a worksheet, to the lowest used row of the rightmost 

used column. 
Ctrl+End 

Extend the selection of cells to the last used cell on the worksheet (lower-

right corner). 
Ctrl+Shift+End 

Move to the cell in the upper-left corner of the window when Scroll Lock is 

turned on. 
Home+Scroll Lock 

Move to the beginning of a worksheet. Ctrl+Home 

Move one screen down in a worksheet. Page Down 

Move to the next sheet in a workbook. Ctrl+Page Down 

Move one screen to the right in a worksheet. Alt+Page Down 

Move one screen up in a worksheet. Page Up 

Move one screen to the left in a worksheet. Alt+Page Up 

Move to the previous sheet in a workbook. Ctrl+Page Up 

Move one cell to the right in a worksheet. Or, in a protected worksheet, move 

between unlocked cells. 
Tab 

Cycle through floating shapes, such as text boxes or images. 
Ctrl+Alt+5, and then the 

Tab key repeatedly 



To do this  Press  

Exit the floating shape navigation and return to the normal navigation. Esc 

Top of Page  

Keyboard shortcuts for formatting cells 

To do this  Press  

Open the Format Cells dialog box. Ctrl+1 

Format fonts in the Format Cells dialog box. 
Ctrl+Shift+F or 

Ctrl+Shift+P 

Edit the active cell and put the insertion point at the end of its contents. Or, if 

editing is turned off for the cell, move the insertion point into the formula bar. 

If editing a formula, toggle Point mode off or on so you can use arrow keys to 

create a reference. 

F2 

Add or edit a cell comment. Shift+F2 

Open the Insert dialog to insert blank cells. Ctrl+Shift+Plus (+) 

Open the Delete dialog box to delete selected cells. Ctrl+Minus (-) 

Enter the current time. Ctrl+Shift+colon (:) 

Enter the current date. Ctrl+semi-colon (;) 

Switch between displaying cell values or formulas in the worksheet. Ctrl+grave accent (`) 

Copy a formula from the cell above the active cell into the cell or the Formula 

Bar. 
Ctrl+apostrophe (') 

Move the selected cells. Ctrl+X 

Copy the selected cells. Ctrl+C 

Paste content at the insertion point, replacing any selection. Ctrl+V 

Open the Paste Special dialog box. Ctrl+Alt+V 

Italicize text or remove italic formatting. Ctrl+I or Ctrl+3 
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To do this  Press  

Bold text or remove bold formatting. Ctrl+B or Ctrl+2 

Underline text or remove underline. Ctrl+U or Ctrl+4 

Apply or remove strikethrough formatting. Ctrl+5 

Switch between hiding objects, displaying objects, and displaying placeholders 

for objects. 
Ctrl+6 

Apply an outline border to the selected cells. 
Ctrl+Shift+ampersand 

(&) 

Remove the outline border from the selected cells. Ctrl+Shift+underline (_) 

Display or hide the outline symbols. Ctrl+8 

Use the Fill Down command to copy the contents and format of the topmost 

cell of a selected range into the cells below. 
Ctrl+D 

Apply the General number format. Ctrl+Shift+tilde (~) 

Apply the Currency format with two decimal places (negative numbers in 

parentheses). 
Ctrl+Shift+dollar sign ($) 

Apply the Percentage format with no decimal places. Ctrl+Shift+percent (%) 

Apply the Scientific number format with two decimal places. Ctrl+Shift+caret (^) 

Apply the Date format with the day, month, and year. 
Ctrl+Shift+number sign 

(#) 

Apply the Time format with the hour and minute, and AM or PM. Ctrl+Shift+at sign (@) 

Apply the Number format with two decimal places, thousands separator, and 

minus sign (-) for negative values. 

Ctrl+Shift+exclamation 

point (!) 

Open the Insert hyperlink dialog. Ctrl+K 

Check spelling in the active worksheet or selected range. F7 

Display the Quick Analysis options for selected cells that contain data. Ctrl+Q 



To do this  Press  

Display the Create Table dialog box. Ctrl+L or Ctrl+T 
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Keyboard shortcuts for making selections and performing actions 

To do this  Press  

Select the entire worksheet. Ctrl+A or Ctrl+Shift+Spacebar 

Select the current and next sheet in a workbook. Ctrl+Shift+Page Down 

Select the current and previous sheet in a workbook. Ctrl+Shift+Page Up 

Extend the selection of cells by one cell. Shift+arrow key 

Extend the selection of cells to the last nonblank cell in the 

same column or row as the active cell, or if the next cell is 

blank, to the next nonblank cell. 

Ctrl+Shift+arrow key 

Turn extend mode on and use the arrow keys to extend a 

selection. Press again to turn off. 

Turn extend mode on and use the arrow 

keys to extend a selection. Press again to 

turn off. F8 

Add a non-adjacent cell or range to a selection of cells by 

using the arrow keys. 
Shift+F8 

Start a new line in the same cell. Alt+Enter 

Fill the selected cell range with the current entry. Ctrl+Enter 

Complete a cell entry and select the cell above. Shift+Enter 

Select an entire column in a worksheet. Ctrl+Spacebar 

Select an entire row in a worksheet. Shift+Spacebar 

Select all objects on a worksheet when an object is selected. Ctrl+Shift+Spacebar 

Extend the selection of cells to the beginning of the 

worksheet. 
Ctrl+Shift+Home 
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To do this  Press  

Select the current region if the worksheet contains data. 

Press a second time to select the current region and its 

summary rows. Press a third time to select the entire 

worksheet. 

Ctrl+A or Ctrl+Shift+Spacebar 

Select the current region around the active cell or select an 

entire PivotTable report. 
Ctrl+Shift+asterisk (*) 

Select the first command on the menu when a menu or 

submenu is visible. 
Home 

Repeat the last command or action, if possible. Ctrl+Y 

Undo the last action. Ctrl+Z 
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Keyboard shortcuts for working with data, functions, and the formula bar 

To do this  Press  

Select an entire PivotTable report. Ctrl+Shift+asterisk (*) 

Edit the active cell and put the insertion point at the end of its contents. Or, if 

editing is turned off for the cell, move the insertion point into the formula bar. If 

editing a formula, toggle Point mode off or on so you can use arrow keys to 

create a reference. 

F2 

Expand or collapse the formula bar. Ctrl+Shift+U 

Cancel an entry in the cell or Formula Bar. Esc 

Complete an entry in the formula bar and select the cell below. Enter 

Move the cursor to the end of the text when in the formula bar. Ctrl+End 

Select all text in the formula bar from the cursor position to the end. Ctrl+Shift+End 

Calculate all worksheets in all open workbooks. F9 

Calculate the active worksheet. Shift+F9 
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To do this  Press  

Calculate all worksheets in all open workbooks, regardless of whether they have 

changed since the last calculation. 
Ctrl+Alt+F9 

Check dependent formulas, and then calculate all cells in all open workbooks, 

including cells not marked as needing to be calculated. 
Ctrl+Alt+Shift+F9 

Display the menu or message for an Error Checking button. Alt+Shift+F10 

Display the Function Arguments dialog box when the insertion point is to the 

right of a function name in a formula. 
Ctrl+A 

Insert argument names and parentheses when the insertion point is to the right 

of a function name in a formula. 
Ctrl+Shift+A 

Invoke Flash Fill to automatically recognize patterns in adjacent columns and fill 

the current column 
Ctrl+E 

Cycle through all combinations of absolute and relative references in a formula 

if a cell reference or range is selected. 
F4 

Insert a function. Shift+F3 

Copy the value from the cell above the active cell into the cell or the formula 

bar. 

Ctrl+Shift+straight 

quotation mark (") 

Create an embedded chart of the data in the current range. Alt+F1 

Create a chart of the data in the current range in a separate Chart sheet. F11 

Define a name to use in references. Alt+M, M, D 

Paste a name from the Paste Name dialog box (if names have been defined in 

the workbook. 
F3 

Move to the first field in the next record of a data form. Enter 

Create, run, edit, or delete a macro. Alt+F8 

Open the Microsoft Visual Basic For Applications Editor. Alt+F11 
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Function keys 
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Key Description 

F1 

F1 alone: displays the Excel Help task pane. 

Ctrl+F1: displays or hides the ribbon. 

Alt+F1: creates an embedded chart of the data in the current range. 

Alt+Shift+F1: inserts a new worksheet. 

F2 

F2 alone: edit the active cell and put the insertion point at the end of its contents. Or, if editing is 

turned off for the cell, move the insertion point into the formula bar. If editing a formula, toggle 

Point mode off or on so you can use arrow keys to create a reference. 

Shift+F2: adds or edits a cell comment. 

Ctrl+F2: displays the print preview area on the Print tab in the Backstage view. 

F3 

F3 alone: displays the Paste Name dialog box. Available only if names have been defined in the 

workbook. 

Shift+F3: displays the Insert Function dialog box. 

F4 

F4 alone: repeats the last command or action, if possible. 

When a cell reference or range is selected in a formula, F4 cycles through all the various 

combinations of absolute and relative references. 

Ctrl+F4: closes the selected workbook window. 

Alt+F4: closes Excel. 

F5 
F5 alone: displays the Go To dialog box. 

Ctrl+F5: restores the window size of the selected workbook window. 

F6 

F6 alone: switches between the worksheet, ribbon, task pane, and Zoom controls. In a worksheet 

that has been split , F6 includes the split panes when switching between panes and the ribbon area. 

Shift+F6: switches between the worksheet, Zoom controls, task pane, and ribbon. 

Ctrl+F6: switches to the next workbook window when more than one workbook window is open. 

F7 
F7 alone: Opens the Spelling dialog box to check spelling in the active worksheet or selected range. 

Ctrl+F7: performs the Move command on the workbook window when it is not maximized. Use the 



Key Description 

arrow keys to move the window, and when finished press Enter, or Esc to cancel. 

F8 alone: turns extend mode on or off. In extend mode, Extended Selection appears in the status 

line, and the arrow keys extend the selection. 

F8 

Shift+F8: enables you to add a nonadjacent cell or range to a selection of cells by using the arrow 

keys. 

Ctrl+F8: performs the Size command when a workbook is not maximized. 

Alt+F8: displays the Macro dialog box to create, run, edit, or delete a macro. 

F9 

F9 alone: calculates all worksheets in all open workbooks. 

Shift+F9: calculates the active worksheet. 

Ctrl+Alt+F9: calculates all worksheets in all open workbooks, regardless of whether they have 

changed since the last calculation. 

Ctrl+Alt+Shift+F9: rechecks dependent formulas, and then calculates all cells in all open workbooks, 

including cells not marked as needing to be calculated. 

Ctrl+F9: minimizes a workbook window to an icon. 

F10 

F10 alone: Turns key tips on or off. (Pressing Alt does the same thing.) 

Shift+F10: displays the shortcut menu for a selected item. 

Alt+Shift+F10: displays the menu or message for an Error Checking button. 

Ctrl+F10: maximizes or restores the selected workbook window. 

F11 

F11 alone: Creates a chart of the data in the current range in a separate Chart sheet. 

Shift+F11: inserts a new worksheet. 

Alt+F11: opens the Microsoft Visual Basic For Applications Editor, in which you can create a macro 

by using Visual Basic for Applications (VBA). 

F12 F12 alone: displays the Save As dialog box. 
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Other useful shortcut keys 
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Key  Description  

Alt 

Displays the Key Tips (new shortcuts) on the ribbon. 

For example, 

Alt, W, P switches the worksheet to Page Layout view. 

Alt, W, L switches the worksheet to Normal view. 

Alt, W, I switches the worksheet to Page Break Preview view. 

Arrow 

Keys 

Move one cell up, down, left, or right in a worksheet. 

Ctrl+Arrow Key moves to the edge of the current data region in a worksheet. 

Shift+Arrow Key extends the selection of cells by one cell. 

Ctrl+Shift+Arrow Key extends the selection of cells to the last nonblank cell in the same 

column or row as the active cell, or if the next cell is blank, extends the selection to the next 

nonblank cell. 

Left Arrow or Right Arrow selects the tab to the left or right when the ribbon is selected. 

When a submenu is open or selected, these arrow keys switch between the main menu and 

the submenu. When a ribbon tab is selected, these keys navigate the tab buttons. 

Down Arrow or Up Arrow selects the next or previous command when a menu or submenu is 

open. When a ribbon tab is selected, these keys navigate up or down the tab group. 

In a dialog box, arrow keys move between options in an open drop-down list, or between 

options in a group of options. 

Down Arrow or Alt+Down Arrow opens a selected drop-down list. 

Backspace 

Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 

Delete 

Removes the cell contents (data and formulas) from selected cells without affecting cell 

formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

End End turns End mode on or off. In End mode, you can press an arrow key to move to the next 

nonblank cell in the same column or row as the active cell. End mode turns off automatically 



Key  Description  

after pressing the arrow key. Make sure to press End again before pressing the next arrow 

key. End mode is shown in the status bar when it is on. 

If the cells are blank, pressing End followed by an arrow key moves to the last cell in the row 

or column. 

End also selects the last command on the menu when a menu or submenu is visible. 

Ctrl+End moves to the last cell on a worksheet, to the lowest used row of the rightmost used 

column. If the cursor is in the formula bar, Ctrl+End moves the cursor to the end of the text. 

Ctrl+Shift+End extends the selection of cells to the last used cell on the worksheet (lower-

right corner). If the cursor is in the formula bar, Ctrl+Shift+End selects all text in the formula 

bar from the cursor position to the end—this does not affect the height of the formula bar. 

Enter 

Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by 

default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a 

selected command. 

In a dialog box, it performs the action for the default command button in the dialog box (the 

button with the bold outline, often the OK button). 

Alt+Enter starts a new line in the same cell. 

Ctrl+Enter fills the selected cell range with the current entry. 

Shift+Enter completes a cell entry and selects the cell above. 

Esc 

Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialog box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to normal 

screen mode to display the ribbon and status bar again. 

Home 

Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when Scroll Lock is turned on. 

Selects the first command on the menu when a menu or submenu is visible. 



Key  Description  

Ctrl+Home moves to the beginning of a worksheet. 

Ctrl+Shift+Home extends the selection of cells to the beginning of the worksheet. 

Page 

Down 

Moves one screen down in a worksheet. 

Alt+Page Down moves one screen to the right in a worksheet. 

Ctrl+Page Down moves to the next sheet in a workbook. 

Ctrl+Shift+Page Down selects the current and next sheet in a workbook. 

Page Up 

Moves one screen up in a worksheet. 

Alt+Page Up moves one screen to the left in a worksheet. 

Ctrl+Page Up moves to the previous sheet in a workbook. 

Ctrl+Shift+Page Up selects the current and previous sheet in a workbook. 

Spacebar 

In a dialog box, performs the action for the selected button, or selects or clears a check box. 

Ctrl+Spacebar selects an entire column in a worksheet. 

Shift+Spacebar selects an entire row in a worksheet. 

Ctrl+Shift+Spacebar selects the entire worksheet. 

If the worksheet contains data, Ctrl+Shift+Spacebar selects the current region. Pressing 

Ctrl+Shift+Spacebar a second time selects the current region and its summary rows. Pressing 

Ctrl+Shift+Spacebar a third time selects the entire worksheet. 

When an object is selected, Ctrl+Shift+Spacebar selects all objects on a worksheet. 

Alt+Spacebar displays the Control menu for the Excel window. 

Tab 

Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialog box. 

Shift+Tab moves to the previous cell in a worksheet or the previous option in a dialog box. 

Ctrl+Tab switches to the next tab in dialog box. 



Key  Description  

Ctrl+Shift+Tab switches to the previous tab in a dialog box. 
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This article describes keyboard shortcuts, function keys, and other common shortcut keys for Excel 2013. 

This includes the shortcuts that you can use to access the Ribbon. 

Tip: To keep this reference available when you work, you may want to print this topic. To print this topic, 

press CTRL+P. 

Note: If an action that you use often does not have a shortcut key, you can record a macro to create one. 

Keyboard access to the ribbon 

If you're new to the Ribbon, the information in this section can help you understand the Ribbon's 

keyboard shortcut model. The Ribbon comes with new shortcuts, called Key Tips, which you can make 

appear when you press the Alt key. 

To display a tab on the Ribbon, press the key for the tab—for example, press the letter N for the Insert 

tab or M for the Formulas tab. This makes all the Key Tip badges for that tab's buttons appear, as shown 

in the following image. Then, press the key for the button you want. 

 

Will my old shortcuts still work? 

Keyboard shortcuts that begin with Ctrl will still work in Microsoft Excel 2013. For example, Ctrl+C still 

copies to the clipboard, and Ctrl+V still pastes from the clipboard. 

Most of the old Alt+ menu shortcuts still work, too. However, you need to know the full shortcut from 

memory — there are no screen reminders of what letters to press. For example, try pressing Alt, and 

then press one of the old menu keys E (Edit), V (View), I (Insert), and so on. A box pops up saying you're 

using an access key from an earlier version of Microsoft Office. If you know the entire key sequence, go 

ahead and initiate the command. If you don't know the sequence, press Esc and use Key Tip badges 

instead. 

Ctrl combination shortcut keys 
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Key  Description  

Ctrl+PgDn Switches between worksheet tabs, from left-to-right. 

Ctrl+PgUp Switches between worksheet tabs, from right-to-left. 

Ctrl+Shift+& Applies the outline border to the selected cells. 

Ctrl+Shift_ Removes the outline border from the selected cells. 

Ctrl+Shift+~ Applies the General number format. 

Ctrl+Shift+$ 
Applies the Currency format with two decimal places (negative numbers in 

parentheses). 

Ctrl+Shift+% Applies the Percentage format with no decimal places. 

Ctrl+Shift+^ Applies the Scientific number format with two decimal places. 

Ctrl+Shift+# Applies the Date format with the day, month, and year. 

Ctrl+Shift+@ Applies the Time format with the hour and minute, and AM or PM. 

Ctrl+Shift+! 
Applies the Number format with two decimal places, thousands separator, and minus 

sign (-) for negative values. 

Ctrl+Shift+* 

Selects the current region around the active cell (the data area enclosed by blank rows 

and blank columns). 

In a PivotTable, it selects the entire PivotTable report. 

Ctrl+Shift+: Enters the current time. 

Ctrl+Shift+" Copies the value from the cell above the active cell into the cell or the Formula Bar. 

Ctrl+Shift+Plus 

(+) 
Displays the Insert dialog box to insert blank cells. 

Ctrl+Minus (-) Displays the Delete dialog box to delete the selected cells. 

Ctrl+; Enters the current date. 

Ctrl+` Alternates between displaying cell values and displaying formulas in the worksheet. 



Key  Description  

Ctrl+' Copies a formula from the cell above the active cell into the cell or the Formula Bar. 

Ctrl+1 Displays the Format Cells dialog box. 

Ctrl+2 Applies or removes bold formatting. 

Ctrl+3 Applies or removes italic formatting. 

Ctrl+4 Applies or removes underlining. 

Ctrl+5 Applies or removes strikethrough. 

Ctrl+6 Alternates between hiding and displaying objects. 

Ctrl+8 Displays or hides the outline symbols. 

Ctrl+9 Hides the selected rows. 

Ctrl+0 Hides the selected columns. 

Ctrl+A 

Selects the entire worksheet. 

If the worksheet contains data, Ctrl+A selects the current region. Pressing Ctrl+A a 

second time selects the entire worksheet. 

When the insertion point is to the right of a function name in a formula, displays the 

Function Arguments dialog box. 

Ctrl+Shift+A inserts the argument names and parentheses when the insertion point is 

to the right of a function name in a formula. 

Ctrl+B Applies or removes bold formatting. 

Ctrl+C Copies the selected cells. 

Ctrl+D 
Uses the Fill Down command to copy the contents and format of the topmost cell of a 

selected range into the cells below. 

Ctrl+E 
Invoke Flash Fill to automatically recognize patterns in adjacent columns and fill the 

current column 

Ctrl+F Displays the Find and Replace dialog box, with the Find tab selected. 

https://support.office.com/en-us/article/Flash-Fill-2e79a709-c814-4b27-8bc2-c4dc84d49464


Key  Description  

Shift+F5 also displays this tab, while Shift+F4 repeats the last Find action. 

Ctrl+Shift+F opens the Format Cells dialog box with the Font tab selected. 

Ctrl+G 
Displays the Go To dialog box. 

F5 also displays this dialog box. 

Ctrl+H Displays the Find and Replace dialog box, with the Replace tab selected. 

Ctrl+I Applies or removes italic formatting. 

Ctrl+K 
Displays the Insert Hyperlink dialog box for new hyperlinks or the Edit Hyperlink dialog 

box for selected existing hyperlinks. 

Ctrl+L Displays the Create Table dialog box. 

Ctrl+N Creates a new, blank workbook. 

Ctrl+O 
Displays the Open dialog box to open or find a file. 

Ctrl+Shift+O selects all cells that contain comments. 

Ctrl+P 
Displays the Print tab in Microsoft Office Backstage view. 

Ctrl+Shift+P opens the Format Cells dialog box with the Font tab selected. 

Ctrl+Q 
Displays the Quick Analysis options for your data when you have cells that contain that 

data selected. 

Ctrl+R 
Uses the Fill Right command to copy the contents and format of the leftmost cell of a 

selected range into the cells to the right. 

Ctrl+S Saves the active file with its current file name, location, and file format. 

Ctrl+T Displays the Create Table dialog box. 

Ctrl+U 
Applies or removes underlining. 

Ctrl+Shift+U switches between expanding and collapsing of the formula bar. 

Ctrl+V 
Inserts the contents of the Clipboard at the insertion point and replaces any selection. 

Available only after you have cut or copied an object, text, or cell contents. 



Key  Description  

Ctrl+Alt+V displays the Paste Special dialog box. Available only after you have cut or 

copied an object, text, or cell contents on a worksheet or in another program. 

Ctrl+W Closes the selected workbook window. 

Ctrl+X Cuts the selected cells. 

Ctrl+Y Repeats the last command or action, if possible. 

Ctrl+Z 
Uses the Undo command to reverse the last command or to delete the last entry that 

you typed. 

Tip: The Ctrl combinations Ctrl+J and Ctrl+M are currently unassigned shortcuts. 
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Function keys 

Key  Description  

F1 

Displays the Excel Help task pane. 

Ctrl+F1 displays or hides the Ribbon. 

Alt+F1 creates an embedded chart of the data in the current range. 

Alt+Shift+F1 inserts a new worksheet. 

F2 

Edits the active cell and positions the insertion point at the end of the cell contents. It also moves 

the insertion point into the Formula Bar when editing in a cell is turned off. 

Shift+F2 adds or edits a cell comment. 

Ctrl+F2 displays the print preview area on the Print tab in the Backstage view. 

F3 

Displays the Paste Name dialog box. Available only if names have been defined in the workbook 

(Formulas tab, Defined Names group, Define Name). 

Shift+F3 displays the Insert Function dialog box. 

F4 

Repeats the last command or action, if possible. 

When a cell reference or range is selected in a formula, F4 cycles through all the various 

combinations of absolute and relative references. 
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Key  Description  

Ctrl+F4 closes the selected workbook window. 

Alt+F4 closes Excel. 

F5 
Displays the Go To dialog box. 

Ctrl+F5 restores the window size of the selected workbook window. 

F6 

Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has 

been split (View menu, Manage This Window, Freeze Panes, Split Window command), F6 includes 

the split panes when switching between panes and the Ribbon area. 

Shift+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon. 

Ctrl+F6 switches to the next workbook window when more than one workbook window is open. 

F7 

Displays the Spelling dialog box to check spelling in the active worksheet or selected range. 

Ctrl+F7 performs the Move command on the workbook window when it is not maximized. Use the 

arrow keys to move the window, and when finished press Enter, or Esc to cancel. 

F8 

Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the 

arrow keys extend the selection. 

Shift+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow 

keys. 

Ctrl+F8 performs the Size command (on the Control menu for the workbook window) when a 

workbook is not maximized. 

Alt+F8 displays the Macro dialog box to create, run, edit, or delete a macro. 

F9 

Calculates all worksheets in all open workbooks. 

Shift+F9 calculates the active worksheet. 

Ctrl+Alt+F9 calculates all worksheets in all open workbooks, regardless of whether they have 

changed since the last calculation. 

Ctrl+Alt+Shift+F9 rechecks dependent formulas, and then calculates all cells in all open workbooks, 

including cells not marked as needing to be calculated. 

Ctrl+F9 minimizes a workbook window to an icon. 



Key  Description  

F10 

Turns key tips on or off. (Pressing Alt does the same thing.) 

Shift+F10 displays the shortcut menu for a selected item. 

Alt+Shift+F10 displays the menu or message for an Error Checking button. 

Ctrl+F10 maximizes or restores the selected workbook window. 

F11 

Creates a chart of the data in the current range in a separate Chart sheet. 

Shift+F11 inserts a new worksheet. 

Alt+F11 opens the Microsoft Visual Basic For Applications Editor, in which you can create a macro by 

using Visual Basic for Applications (VBA). 

F12 Displays the Save As dialog box. 
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Other useful shortcuts 

Key  Description  

Alt 

Displays the Key Tips (new shortcuts) on the Ribbon. 

For example, 

Alt, W, P switches the worksheet to Page Layout view. 

Alt, W, L switches the worksheet to Normal view. 

Alt, W, I switches the worksheet to Page Break Preview view. 

Arrow 

Keys 

Move one cell up, down, left, or right in a worksheet. 

Ctrl+Arrow Key moves to the edge of the current data region in a worksheet. 

Shift+Arrow Key extends the selection of cells by one cell. 

Ctrl+Shift+Arrow Key extends the selection of cells to the last nonblank cell in the same 

column or row as the active cell, or if the next cell is blank, extends the selection to the next 

nonblank cell. 

Left Arrow or Right Arrow selects the tab to the left or right when the Ribbon is selected. 

When a submenu is open or selected, these arrow keys switch between the main menu and 
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Key  Description  

the submenu. When a Ribbon tab is selected, these keys navigate the tab buttons. 

Down Arrow or Up Arrow selects the next or previous command when a menu or submenu is 

open. When a Ribbon tab is selected, these keys navigate up or down the tab group. 

In a dialog box, arrow keys move between options in an open drop-down list, or between 

options in a group of options. 

Down Arrow or Alt+Down Arrow opens a selected drop-down list. 

Backspace 

Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 

Delete 

Removes the cell contents (data and formulas) from selected cells without affecting cell 

formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

End 

End turns End mode on or off. In End mode, you can press an arrow key to move to the next 

nonblank cell in the same column or row as the active cell. End mode turns off automatically 

after pressing the arrow key. Make sure to press End again before pressing the next arrow 

key. End mode is shown in the status bar when it is on. 

If the cells are blank, pressing End followed by an arrow key moves to the last cell in the row 

or column. 

End also selects the last command on the menu when a menu or submenu is visible. 

Ctrl+End moves to the last cell on a worksheet, to the lowest used row of the rightmost used 

column. If the cursor is in the formula bar, Ctrl+End moves the cursor to the end of the text. 

Ctrl+Shift+End extends the selection of cells to the last used cell on the worksheet (lower-

right corner). If the cursor is in the formula bar, Ctrl+Shift+End selects all text in the formula 

bar from the cursor position to the end—this does not affect the height of the formula bar. 

Enter 

Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by 

default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a 



Key  Description  

selected command. 

In a dialog box, it performs the action for the default command button in the dialog box (the 

button with the bold outline, often the OK button). 

Alt+Enter starts a new line in the same cell. 

Ctrl+Enter fills the selected cell range with the current entry. 

Shift+Enter completes a cell entry and selects the cell above. 

Esc 

Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialog box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to normal 

screen mode to display the Ribbon and status bar again. 

Home 

Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when Scroll Lock is turned on. 

Selects the first command on the menu when a menu or submenu is visible. 

Ctrl+Home moves to the beginning of a worksheet. 

Ctrl+Shift+Home extends the selection of cells to the beginning of the worksheet. 

Page 

Down 

Moves one screen down in a worksheet. 

Alt+Page Down moves one screen to the right in a worksheet. 

Ctrl+Page Down moves to the next sheet in a workbook. 

Ctrl+Shift+Page Down selects the current and next sheet in a workbook. 

Page Up 

Moves one screen up in a worksheet. 

Alt+Page Up moves one screen to the left in a worksheet. 

Ctrl+Page Up moves to the previous sheet in a workbook. 

Ctrl+Shift+Page Up selects the current and previous sheet in a workbook. 

Spacebar In a dialog box, performs the action for the selected button, or selects or clears a check box. 



Key  Description  

Ctrl+Spacebar selects an entire column in a worksheet. 

Shift+Spacebar selects an entire row in a worksheet. 

Ctrl+Shift+Spacebar selects the entire worksheet. 

If the worksheet contains data, Ctrl+Shift+Spacebar selects the current region. Pressing 

Ctrl+Shift+Spacebar a second time selects the current region and its summary rows. Pressing 

Ctrl+Shift+Spacebar a third time selects the entire worksheet. 

When an object is selected, Ctrl+Shift+Spacebar selects all objects on a worksheet. 

Alt+Spacebar displays the Control menu for the Excel window. 

Tab 

Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialog box. 

Shift+Tab moves to the previous cell in a worksheet or the previous option in a dialog box. 

Ctrl+Tab switches to the next tab in dialog box. 

Ctrl+Shift+Tab switches to the previous tab in a dialog box. 
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This article describes keyboard shortcuts, function keys, and some other common shortcut keys for Excel 

2010. This includes the shortcuts that you can use to access the Ribbon. 

Note: If you are using Microsoft Excel Starter 2010, be aware that not all the features listed for Excel are 

supported in Excel Starter 2010. 

Tip: To keep this reference available when you work, you may want to print this topic. To print this topic, 

press CTRL+P. 

Note: If an action that you use often does not have a shortcut key, you can record a macro to create one. 

Will my old shortcuts still work?  

CTRL combination shortcut keys  

Function keys  

Other useful shortcut keys  
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Keyboard access to the ribbon 

If you're new to the Ribbon, the information in this section can help you understand the Ribbon's 

keyboard shortcut model. The Ribbon comes with new shortcuts, called Key Tips, which you can make 

appear when you press the Alt key. 

 

To display a tab on the Ribbon, press the key for the tab—for example, press the letter N for the Insert 

tab or M for the Formulas tab. This makes all the Key Tip badges for that tab's buttons appear. Then, 

press the key for the button you want. 

Will my old shortcuts still work? 

Keyboard shortcuts that begin with CTRL will still work in Excel 2010. For example, CTRL+C still copies to 

the clipboard, and CTRL+V still pastes from the clipboard. 

Most of the old ALT+ menu shortcuts still work, too. However, you need to know the full shortcut from 

memory — there are no screen reminders of what letters to press. For example, try pressing ALT, and 

then press one of the old menu keys E (Edit), V (View), I (Insert), and so on. A box pops up saying you're 

using an access key from an earlier version of Microsoft Office. If you know the entire key sequence, go 

ahead and initiate the command. If you don't know the sequence, press ESC and use Key Tip badges 

instead. 

Ctrl combination shortcut keys 

Tip: Download or print a Quick Reference Card: Keyboard Shortcuts - Ctrl keys. (PDF) 

Key  Description  

CTRL+PgUp Switches between worksheet tabs, from left-to-right. 

CTRL+PgDn Switches between worksheet tabs, from right-to-left. 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

http://download.microsoft.com/download/8/a/f/8afa341a-a79c-41c4-9539-16957e9a8363/AF102692107_en-us_excel%202010%20kb%20shorts_ctrl.pdf&#13;&#10;


Key  Description  

CTRL+SHIFT+~ Applies the General number format. 

CTRL+SHIFT+$ 
Applies the Currency format with two decimal places (negative numbers in 

parentheses). 

CTRL+SHIFT+% Applies the Percentage format with no decimal places. 

CTRL+SHIFT+^ Applies the Scientific number format with two decimal places. 

CTRL+SHIFT+# Applies the Date format with the day, month, and year. 

CTRL+SHIFT+@ Applies the Time format with the hour and minute, and AM or PM. 

CTRL+SHIFT+! 
Applies the Number format with two decimal places, thousands separator, and 

minus sign (-) for negative values. 

CTRL+SHIFT+* 

Selects the current region around the active cell (the data area enclosed by blank 

rows and blank columns). 

In a PivotTable, it selects the entire PivotTable report. 

CTRL+SHIFT+: Enters the current time. 

CTRL+SHIFT+" Copies the value from the cell above the active cell into the cell or the Formula Bar. 

CTRL+SHIFT+Plus 

(+) 
Displays the Insert dialog box to insert blank cells. 

CTRL+Minus (-) Displays the Delete dialog box to delete the selected cells. 

CTRL+; Enters the current date. 

CTRL+` Alternates between displaying cell values and displaying formulas in the worksheet. 

CTRL+' Copies a formula from the cell above the active cell into the cell or the Formula Bar. 

CTRL+1 Displays the Format Cells dialog box. 

CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 



Key  Description  

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 Alternates between hiding and displaying objects. 

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A 

Selects the entire worksheet. 

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a 

second time selects the entire worksheet. 

When the insertion point is to the right of a function name in a formula, displays the 

Function Arguments dialog box. 

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion 

point is to the right of a function name in a formula. 

CTRL+B Applies or removes bold formatting. 

CTRL+C Copies the selected cells. 

CTRL+D 
Uses the Fill Down command to copy the contents and format of the topmost cell of 

a selected range into the cells below. 

CTRL+F 

Displays the Find and Replace dialog box, with the Find tab selected. 

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action. 

CTRL+SHIFT+F opens the Format Cells dialog box with the Font tab selected. 

CTRL+G 
Displays the Go To dialog box. 

F5 also displays this dialog box. 

CTRL+H Displays the Find and Replace dialog box, with the Replace tab selected. 

CTRL+I Applies or removes italic formatting. 



Key  Description  

CTRL+K 
Displays the Insert Hyperlink dialog box for new hyperlinks or the Edit Hyperlink 

dialog box for selected existing hyperlinks. 

CTRL+L Displays the Create Table dialog box. 

CTRL+N Creates a new, blank workbook. 

CTRL+O 
Displays the Open dialog box to open or find a file. 

CTRL+SHIFT+O selects all cells that contain comments. 

CTRL+P 
Displays the Print tab in Microsoft Office Backstage view. 

CTRL+SHIFT+P opens the Format Cells dialog box with the Font tab selected. 

CTRL+R 
Uses the Fill Right command to copy the contents and format of the leftmost cell of a 

selected range into the cells to the right. 

CTRL+S Saves the active file with its current file name, location, and file format. 

CTRL+T Displays the Create Table dialog box. 

CTRL+U 
Applies or removes underlining. 

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar. 

CTRL+V 

Inserts the contents of the Clipboard at the insertion point and replaces any 

selection. Available only after you have cut or copied an object, text, or cell contents. 

CTRL+ALT+V displays the Paste Special dialog box. Available only after you have cut 

or copied an object, text, or cell contents on a worksheet or in another program. 

CTRL+W Closes the selected workbook window. 

CTRL+X Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z 
Uses the Undo command to reverse the last command or to delete the last entry that 

you typed. 

Tip: The CTRL combinations CTRL+E, CTRL+J, CTRL+M, and CTRL+Q are currently unassigned shortcuts. 
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Function keys 

Tip: Download or print a Quick Reference Card: Keyboard Shortcuts - Function keys. (PDF) 

Key  Description  

F1 

Displays the Excel Help task pane. 

CTRL+F1 displays or hides the Ribbon. 

ALT+F1 creates an embedded chart of the data in the current range. 

ALT+SHIFT+F1 inserts a new worksheet. 

F2 

Edits the active cell and positions the insertion point at the end of the cell contents. It also moves 

the insertion point into the Formula Bar when editing in a cell is turned off. 

SHIFT+F2 adds or edits a cell comment. 

CTRL+F2 displays the print preview area on the Print tab in the Backstage view. 

F3 
Displays the Paste Name dialog box. Available only if there are existing names in the workbook. 

SHIFT+F3 displays the Insert Function dialog box. 

F4 

Repeats the last command or action, if possible. 

When a cell reference or range is selected in a formula, F4 cycles through all the various 

combinations of absolute and relative references. 

CTRL+F4 closes the selected workbook window. 

ALT+F4 closes Excel. 

F5 
Displays the Go To dialog box. 

CTRL+F5 restores the window size of the selected workbook window. 

F6 

Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has 

been split (View menu, Manage This Window, Freeze Panes, Split Window command), F6 includes 

the split panes when switching between panes and the Ribbon area. 

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon. 

CTRL+F6 switches to the next workbook window when more than one workbook window is open. 

F7 Displays the Spelling dialog box to check spelling in the active worksheet or selected range. 

http://download.microsoft.com/download/5/a/7/5a7647bb-74dd-49d4-bafb-707347068055/AF102692116_en-us_excel%202010%20kb%20shorts_function.pdf&#13;&#10;


Key  Description  

CTRL+F7 performs the Move command on the workbook window when it is not maximized. Use the 

arrow keys to move the window, and when finished press ENTER, or ESC to cancel. 

F8 

Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the 

arrow keys extend the selection. 

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow 

keys. 

CTRL+F8 performs the Size command (on the Control menu for the workbook window) when a 

workbook is not maximized. 

ALT+F8 displays the Macro dialog box to create, run, edit, or delete a macro. 

F9 

Calculates all worksheets in all open workbooks. 

SHIFT+F9 calculates the active worksheet. 

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have 

changed since the last calculation. 

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open 

workbooks, including cells not marked as needing to be calculated. 

CTRL+F9 minimizes a workbook window to an icon. 

F10 

Turns key tips on or off. (Pressing ALT does the same thing.) 

SHIFT+F10 displays the shortcut menu for a selected item. 

ALT+SHIFT+F10 displays the menu or message for an Error Checking button. 

CTRL+F10 maximizes or restores the selected workbook window. 

F11 

Creates a chart of the data in the current range in a separate Chart sheet. 

SHIFT+F11 inserts a new worksheet. 

ALT+F11 opens the Microsoft Visual Basic For Applications Editor, in which you can create a macro 

by using Visual Basic for Applications (VBA). 

F12 Displays the Save As dialog box. 
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Other useful shortcuts 

Note: Download or print a Quick Reference Card: Keyboard Shortcuts - Miscellaneous. (PDF) 

Key  Description  

ALT 

Displays the Key Tips (new shortcuts) on the Ribbon. 

For example, 

ALT, W, P switches the worksheet to Page Layout view. 

ALT, W, L switches the worksheet to Normal view. 

ALT, W, I switches the worksheet to Page Break Preview view. 

ARROW 

KEYS 

Move one cell up, down, left, or right in a worksheet. 

CTRL+ARROW KEY moves to the edge of the current data region in a worksheet. 

SHIFT+ARROW KEY extends the selection of cells by one cell. 

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same 

column or row as the active cell, or if the next cell is blank, extends the selection to the next 

nonblank cell. 

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is 

selected. When a submenu is open or selected, these arrow keys switch between the main 

menu and the submenu. When a Ribbon tab is selected, these keys navigate the tab 

buttons. 

DOWN ARROW or UP ARROW selects the next or previous command when a menu or 

submenu is open. When a Ribbon tab is selected, these keys navigate up or down the tab 

group. 

In a dialog box, arrow keys move between options in an open drop-down list, or between 

options in a group of options. 

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list. 

BACKSPACE 

Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 
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DELETE 

Removes the cell contents (data and formulas) from selected cells without affecting cell 

formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

END 

END turns End mode on. In End mode, you can then press an arrow key to move to the next 

nonblank cell in the same column or row as the active cell. If the cells are blank, pressing 

END followed by an arrow key moves to the last cell in the row or column. 

END also selects the last command on the menu when a menu or submenu is visible. 

CTRL+END moves to the last cell on a worksheet, to the lowest used row of the rightmost 

used column. If the cursor is in the formula bar, CTRL+END moves the cursor to the end of 

the text. 

CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet 

(lower-right corner). If the cursor is in the formula bar, CTRL+SHIFT+END selects all text in 

the formula bar from the cursor position to the end—this does not affect the height of the 

formula bar. 

ENTER 

Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by 

default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a 

selected command. 

In a dialog box, it performs the action for the default command button in the dialog box 

(the button with the bold outline, often the OK button). 

ALT+ENTER starts a new line in the same cell. 

CTRL+ENTER fills the selected cell range with the current entry. 

SHIFT+ENTER completes a cell entry and selects the cell above. 

ESC 

Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialog box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to normal 

screen mode to display the Ribbon and status bar again. 
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HOME 

Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on. 

Selects the first command on the menu when a menu or submenu is visible. 

CTRL+HOME moves to the beginning of a worksheet. 

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet. 

PAGE 

DOWN 

Moves one screen down in a worksheet. 

ALT+PAGE DOWN moves one screen to the right in a worksheet. 

CTRL+PAGE DOWN moves to the next sheet in a workbook. 

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook. 

PAGE UP 

Moves one screen up in a worksheet. 

ALT+PAGE UP moves one screen to the left in a worksheet. 

CTRL+PAGE UP moves to the previous sheet in a workbook. 

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook. 

SPACEBAR 

In a dialog box, performs the action for the selected button, or selects or clears a check box. 

CTRL+SPACEBAR selects an entire column in a worksheet. 

SHIFT+SPACEBAR selects an entire row in a worksheet. 

CTRL+SHIFT+SPACEBAR selects the entire worksheet. 

If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing 

CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. 

Pressing CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet. 

When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet. 

ALT+SPACEBAR displays the Control menu for the Excel window. 

TAB 
Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 
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Moves to the next option or option group in a dialog box. 

SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialog box. 

CTRL+TAB switches to the next tab in dialog box. 

CTRL+SHIFT+TAB switches to the previous tab in a dialog box. 
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This article describes keyboard shortcuts, function keys, and some other common shortcut keys for Excel 

2007. This includes the shortcuts that you can use to access the Ribbon. 

Tip: To keep this reference available when you work, you may want to print this topic. To print this topic, 

press CTRL+P. 

Note: If an action that you use often does not have a shortcut key, you can record a macro to create one. 

CTRL combination shortcut keys 

Key  Description  

CTRL+PgUp Switches between worksheet tabs, from left-to-right. 

CTRL+PgDn Switches between worksheet tabs, from right-to-left. 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+) Unhides any hidden columns within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

CTRL+SHIFT+~ Applies the General number format. 

CTRL+SHIFT+$ 
Applies the Currency format with two decimal places (negative numbers in 

parentheses). 

CTRL+SHIFT+% Applies the Percentage format with no decimal places. 

CTRL+SHIFT+^ Applies the Exponential number format with two decimal places. 
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CTRL+SHIFT+# Applies the Date format with the day, month, and year. 

CTRL+SHIFT+@ Applies the Time format with the hour and minute, and AM or PM. 

CTRL+SHIFT+! 
Applies the Number format with two decimal places, thousands separator, and minus 

sign (-) for negative values. 

CTRL+SHIFT+* 

Selects the current region around the active cell (the data area enclosed by blank 

rows and blank columns). 

In a PivotTable, it selects the entire PivotTable report. 

CTRL+SHIFT+: Enters the current time. 

CTRL+SHIFT+" Copies the value from the cell above the active cell into the cell or the Formula Bar. 

CTRL+SHIFT+Plus 

(+) 
Displays the Insert dialog box to insert blank cells. 

CTRL+Minus (-) Displays the Delete dialog box to delete the selected cells. 

CTRL+; Enters the current date. 

CTRL+` Alternates between displaying cell values and displaying formulas in the worksheet. 

CTRL+' Copies a formula from the cell above the active cell into the cell or the Formula Bar. 

CTRL+1 Displays the Format Cells dialog box. 

CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 
Alternates between hiding objects, displaying objects, and displaying placeholders for 

objects. 

CTRL+8 Displays or hides the outline symbols. 
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CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A 

Selects the entire worksheet. 

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a 

second time selects the current region and its summary rows. Pressing CTRL+A a third 

time selects the entire worksheet. 

When the insertion point is to the right of a function name in a formula, displays the 

Function Arguments dialog box. 

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point 

is to the right of a function name in a formula. 

CTRL+B Applies or removes bold formatting. 

CTRL+C 
Copies the selected cells. 

CTRL+C followed by another CTRL+C displays the Clipboard. 

CTRL+D 
Uses the Fill Down command to copy the contents and format of the topmost cell of 

a selected range into the cells below. 

CTRL+F 

Displays the Find and Replace dialog box, with the Find tab selected. 

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action. 

CTRL+SHIFT+F opens the Format Cells dialog box with the Font tab selected. 

CTRL+G 
Displays the Go To dialog box. 

F5 also displays this dialog box. 

CTRL+H Displays the Find and Replace dialog box, with the Replace tab selected. 

CTRL+I Applies or removes italic formatting. 

CTRL+K 
Displays the Insert Hyperlink dialog box for new hyperlinks or the Edit Hyperlink 

dialog box for selected existing hyperlinks. 

CTRL+N Creates a new, blank workbook. 
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CTRL+O 
Displays the Open dialog box to open or find a file. 

CTRL+SHIFT+O selects all cells that contain comments. 

CTRL+P 
Displays the Print dialog box. 

CTRL+SHIFT+P opens the Format Cells dialog box with the Font tab selected. 

CTRL+R 
Uses the Fill Right command to copy the contents and format of the leftmost cell of a 

selected range into the cells to the right. 

CTRL+S Saves the active file with its current file name, location, and file format. 

CTRL+T Displays the Create Table dialog box. 

CTRL+U 
Applies or removes underlining. 

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar. 

CTRL+V 

Inserts the contents of the Clipboard at the insertion point and replaces any 

selection. Available only after you have cut or copied an object, text, or cell contents. 

CTRL+ALT+V displays the Paste Special dialog box. Available only after you have cut or 

copied an object, text, or cell contents on a worksheet or in another program. 

CTRL+W Closes the selected workbook window. 

CTRL+X Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z 

Uses the Undo command to reverse the last command or to delete the last entry that 

you typed. 

CTRL+SHIFT+Z uses the Undo or Redo command to reverse or restore the last 

automatic correction when AutoCorrect Smart Tags are displayed. 
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Function keys 

Key  Description  
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F1 

Displays the Microsoft Office Excel Help task pane. 

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent user interface. 

ALT+F1 creates a chart of the data in the current range. 

ALT+SHIFT+F1 inserts a new worksheet. 

F2 

Edits the active cell and positions the insertion point at the end of the cell contents. It also moves 

the insertion point into the Formula Bar when editing in a cell is turned off. 

SHIFT+F2 adds or edits a cell comment. 

CTRL+F2 displays the Print Preview window. 

F3 
Displays the Paste Name dialog box. 

SHIFT+F3 displays the Insert Function dialog box. 

F4 

Repeats the last command or action, if possible. 

When a cell reference or range is selected in a formula, F4 cycles through the various combinations 

of absolute and relative references. 

CTRL+F4 closes the selected workbook window. 

F5 
Displays the Go To dialog box. 

CTRL+F5 restores the window size of the selected workbook window. 

F6 

Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has 

been split (View menu, Manage This Window, Freeze Panes, Split Window command), F6 includes 

the split panes when switching between panes and the Ribbon area. 

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon. 

CTRL+F6 switches to the next workbook window when more than one workbook window is open. 

F7 

Displays the Spelling dialog box to check spelling in the active worksheet or selected range. 

CTRL+F7 performs the Move command on the workbook window when it is not maximized. Use the 

arrow keys to move the window, and when finished press ENTER, or ESC to cancel. 

F8 Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the 
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arrow keys extend the selection. 

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow 

keys. 

CTRL+F8 performs the Size command (on the Control menu for the workbook window) when a 

workbook is not maximized. 

ALT+F8 displays the Macro dialog box to create, run, edit, or delete a macro. 

F9 

Calculates all worksheets in all open workbooks. 

SHIFT+F9 calculates the active worksheet. 

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have 

changed since the last calculation. 

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open 

workbooks, including cells not marked as needing to be calculated. 

CTRL+F9 minimizes a workbook window to an icon. 

F10 

Turns key tips on or off. 

SHIFT+F10 displays the shortcut menu for a selected item. 

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is present, 

it switches to the next smart tag and displays its menu or message. 

CTRL+F10 maximizes or restores the selected workbook window. 

F11 

Creates a chart of the data in the current range. 

SHIFT+F11 inserts a new worksheet. 

ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro by using Visual 

Basic for Applications (VBA). 

F12 Displays the Save As dialog box. 
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Other useful shortcuts 
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ARROW 

KEYS 

Move one cell up, down, left, or right in a worksheet. 

CTRL+ARROW KEY moves to the edge of the current data region in a worksheet. 

SHIFT+ARROW KEY extends the selection of cells by one cell. 

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same 

column or row as the active cell, or if the next cell is blank, extends the selection to the next 

nonblank cell. 

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is 

selected. When a submenu is open or selected, these arrow keys switch between the main 

menu and the submenu. When a Ribbon tab is selected, these keys navigate the tab 

buttons. 

DOWN ARROW or UP ARROW selects the next or previous command when a menu or 

submenu is open. When a Ribbon tab is selected, these keys navigate up or down the tab 

group. 

In a dialog box, arrow keys move between options in an open drop-down list, or between 

options in a group of options. 

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list. 

BACKSPACE 

Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 

DELETE 

Removes the cell contents (data and formulas) from selected cells without affecting cell 

formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

END 

Moves to the cell in the lower-right corner of the window when SCROLL LOCK is turned on. 

Also selects the last command on the menu when a menu or submenu is visible. 

CTRL+END moves to the last cell on a worksheet, in the lowest used row of the rightmost 

used column. If the cursor is in the formula bar, CTRL+END moves the cursor to the end of 

the text. 

CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet 
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(lower-right corner). If the cursor is in the formula bar, CTRL+SHIFT+END selects all text in 

the formula bar from the cursor position to the end—this does not affect the height of the 

formula bar. 

ENTER 

Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by 

default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a 

selected command. 

In a dialog box, it performs the action for the default command button in the dialog box 

(the button with the bold outline, often the OK button). 

ALT+ENTER starts a new line in the same cell. 

CTRL+ENTER fills the selected cell range with the current entry. 

SHIFT+ENTER completes a cell entry and selects the cell above. 

ESC 

Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialog box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to normal 

screen mode to display the Ribbon and status bar again. 

HOME 

Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on. 

Selects the first command on the menu when a menu or submenu is visible. 

CTRL+HOME moves to the beginning of a worksheet. 

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet. 

PAGE 

DOWN 

Moves one screen down in a worksheet. 

ALT+PAGE DOWN moves one screen to the right in a worksheet. 

CTRL+PAGE DOWN moves to the next sheet in a workbook. 

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook. 
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PAGE UP 

Moves one screen up in a worksheet. 

ALT+PAGE UP moves one screen to the left in a worksheet. 

CTRL+PAGE UP moves to the previous sheet in a workbook. 

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook. 

SPACEBAR 

In a dialog box, performs the action for the selected button, or selects or clears a check box. 

CTRL+SPACEBAR selects an entire column in a worksheet. 

SHIFT+SPACEBAR selects an entire row in a worksheet. 

CTRL+SHIFT+SPACEBAR selects the entire worksheet. 

If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing 

CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. 

Pressing CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet. 

When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet. 

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel window. 

TAB 

Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialog box. 

SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialog box. 

CTRL+TAB switches to the next tab in dialog box. 

CTRL+SHIFT+TAB switches to the previous tab in a dialog box 

 


